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Additional Resources
In addition to these Release Notes and HTML Help, Tecplot 
Focus includes access to the following manuals.

• User’s Manual This manual provides a complete 
description of working with Tecplot Focus features.

• Scripting Guide This guide provides Macro and 
Python command syntax and information on working 
with Macro and Python files and commands.

• Quick Reference Guide This guide provides syntax for 
zone header files, macro variables, keyboard shortcuts, 
and more.

• Data Format Guide This guide provides information 
on outputting simulator data to Tecplot Focus file 
format.

• Installation Guide These instructions give a detailed 
description of how to install Tecplot Focus on your 
machine.
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Welcome to Tecplot Focus 2019 R1

Tecplot Focus 2019 R1 contains many improvements from 
Tecplot 360 EX 2019 R1 which is largely focused on our users 
in the geosciences. Read on to see what’s new.

What’s New In Tecplot Focus 2019 R1

Highlights of Tecplot Focus 2019 R1
• TecIO-MPI write speed improved by ~15x via output 

file caching and reducing data exchanges.
• Extracting slices over time more tightly integrated. 

The Data > Extract > Extract Slices Over Time... menu 
option has been removed. Please use Data > Extract > 
Extract Slices... or the Extract Slices... button on the Slice 
Details dialog.

• Saving a layout after extracting primary slices no 
longer forces saving the data.

• Reprise License Manager (RLM) updated to 12.4.

Bug Fixes and Enhancements
• New macro preprocessor directives allow macros to 

skip over newer instructions based on Tecplot revision 
for future backward compatibility.

• Fixed crash when saving a multi-dataset layout with 
the IJK Blanking dialog open.

• Contour levels listed in the Contour Details dialog now 
correctly displays lists for zero-contour-level-groups.

• Added --help command line option.

What’s New In Tecplot Focus 2018 R2

For Geoscientists
• Sequential - Viridis & cmocean colormaps. Which 

colormap you use to represent your data makes a 
difference. Sequential – Viridis is the new default. Also, 
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check out the new cmocean colormaps copyright (c) 
2015 Kristen M. Thyng. For more details on the 
cmocean colormaps visit https://github.com/matplotlib/
cmocean.

• Georeferenced images may now be imported into 
Tecplot Focus. Georeferenced images can provide 
important context when viewing geographic model 
results and work with both 3D and 2D plot types. See 
the video here: https://www.tecplot.com/2018/10/17/
georeferenced-images-in-tecplot-360/.

New Colormaps (and a new Default)!

We’ve added 19 new colormaps to the selection in Tecplot 
Focus, including using Sequential – Viridis by default. Over 
the past decade, research has revealed many negative aspects 
of the Rainbow. That same research has offered better 
colormaps which are perceptually linear or diverging. This 
change of default may affect the result of scripts. If you really 
need Small Rainbow back you can change the default by 
adding the following lines (for example) to your tecplot.cfg 
file:

$!GlobalContour 1 ColorMapName = 'Small Rainbow'
$!GlobalContour 2 ColorMapName = 'Large Rainbow'
$!GlobalContour 3 ColorMapName = 'Diverging – Blue/Red'
$!GlobalContour 4 ColorMapName = 'Small Rainbow'
$!GlobalContour 5 ColorMapName = 'Small Rainbow'
$!GlobalContour 6 ColorMapName = 'Small Rainbow'
$!GlobalContour 7 ColorMapName = 'Small Rainbow'
$!GlobalContour 8 ColorMapName = 'Small Rainbow'

If you have your own custom colormap that you always want 
available, just drop a *.map file in the new ‘colormaps’ 
directory in the installation.

Loader Update
• Excel Add-In now includes the filename in Zone 

Auxiliary Data of each created zone, so you can more 
easily identify from which file the zone originated.

https://www.tecplot.com/2018/10/17/georeferenced-images-in-tecplot-360/
https://www.tecplot.com/2018/10/17/georeferenced-images-in-tecplot-360/
https://github.com/matplotlib/cmocean
https://github.com/matplotlib/cmocean
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Multiselect & Context Menus

Tecplot Focus now allows you to group select multiple items, 
such as text and geometries. We’ve also added brand new 
context menus for text and geometry objects. Give it a shot by 
right-clicking when you have a piece of text selected.

Platform Support Updates

We’ve updated our supported operating systems and plan to 
drop Windows 8.1 in 2019. Please refer to the install guide for 
complete details.
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Bug Fixes
• Updated vectors to ignore parent volume vector values 

if surface values are valid.
• Updated WMF export to use polygons which render 

more precisely in Microsoft Office products.
• Fixed crash when double clicking on certain parts of 

the Quick Macro Panel.
• Enabled the ability to exclude Custom Labels when 

writing a dataset.
• Configuration file now obeys $!DefaultText 

assignments.
• Updated web license key URL in the Install License File 

dialog to point to new My Tecplot portal.
• Altering grid variables now updates face normals.
• Isosurface dialog now allows values larger than 

2147480000.
• Switching image clipping in 2D updates the plot 

immediately.
• Fixed race condition when creating Tecplot's initial 

temporary directory.
• Allowed layouts to contain zero contour levels.
• License expiration display is always available to the 

user.

Bug Fixes & Enhancements in 2018.2.1
• Added option to export animations to a series of 

individual images.
• Updated MPEG-4 to support high resolution 

exporting, loading into HTML5 websites and Windows 
Media Player.

• Fixed crash on Mac when exporting long or high 
supersample animations.

• Export region default changed to All Frames.
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Tecplot Fo cus vs. Tecp lot 360 EX

• Added Animation Speed parameter back to WMV 
export.

• Improved rotational rendering performance when 
exceeding limits in graphics hardware.

Tecplot Focus vs. Tecplot 360 EX
If you need any of the following features, we suggest you 
consider Tecplot 360 EX.

• The ability to load data files containing more than 5 
million data points

• CFD analysis tools, found on the Tecplot 360 EX 
Analyze menu, including integration capabilities

• Access to Tecplot’s new high-performance subzone 
data file format, .szplt

• The ability to load data in CFD formats such as Fluent, 
FLOW-3D, EnSight, ANSYS, OpenFOAM, and more 
through native data loaders

• The ability to load data files containing face-based 
(polygonal and polyhedral) zones

• Access to the following features while you maintain a 
valid TecPLUS subscription:

• Tecplot Chorus, our simulation analytics tool for 
engineers who work with large numbers of cases

• PyTecplot, an interface to the Tecplot engine via the 
Python programming language

• Tecplot SZL Server, which gives you simple, secure 
access to your Linux-hosted remote data

TecPLUS is the replacement for Software Maintenance 
Service (SMS).

Usage Data Collection
To help us better understand how our customers use our 
products and improve them further, Tecplot Focus includes 
an analytics feature that reports user activity over the 
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Internet using the Google Analytics™ platform. This feature 
tells us which dialogs you use and which controls you 
manipulate in them. However, to protect your privacy and 
trade secrets, we do not see names associated with your data 
(such as variable, zone, or file names) or the actual values of 
fields in dialogs, nor do we receive any information about 
you or your organization’s identity.

If you do not wish to participate in this program, turn off 
“Collect Anonymous Usage Data” in the Help menu.

We receive basic information about your operating system, 
product version, and license at each launch of Tecplot Focus, 
even if you have opted out of the usage data program. This 
information is not tied to any usage data collected.

No usage data of any kind is collected if you do not have 
access to the Internet or if the Google Analytics service is 
blocked by a firewall.

Remote Display
Linux systems can use X Windows to display Tecplot Focus 
on a separate system from the one on which Tecplot Focus is 
actually running. Your X display software must support the 
GLX OpenGL Extensions, or you must have the graphics 
rendered by the host CPU using the Mesa software renderer 
(tecfocus -mesa).

Linux remote users may find performance better using 
remote desktop software instead of X. In our tests, the HP 
Remote Graphics Software was generally the most 
performant such solution when one or the other systems was 
Linux-based. 

On Windows systems, you can use the included Remote 
Desktop Connection, which transmits the entire user 
interface to a remote computer. This allows the rendering to 
be performed in hardware on the host computer and the 
results transmitted across the network. On server versions of 

https://www8.hp.com/us/en/workstations/remote-graphics-software.html
https://www8.hp.com/us/en/workstations/remote-graphics-software.html
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Windows, more than one simultaneous session of this type 
can be supported. ThinAnywhere is a plug-in that can 
improve the remote performance of 3D applications over 
slow networks.

On Mac, use the Screen Sharing feature, which can be 
enabled in the Sharing control panel (or a third-party 
equivalent such as Vine Server, which may provide better 
performance in some situations), and a VNC client, such as 
Chicken of the VNC.

Remote desktop software is generally not suitable for 
situations in which multiple remote users need to run GUI 
applications such as Tecplot Focus on the host system at the 
same time. In these situations, X on Linux is generally the 
preferred solution.

Crash Reporting
Please help us make Tecplot Focus better by submitting a 
crash report to us in the event that the application terminates 
unexpectedly.

On Windows, Tecplot Focus creates a crash dump file. You 
will receive a message indicating that a crash dump file has 
been created. Click Yes in this dialog to open the folder 
where the file is created. You can then e-mail the most recent 
.dmp file in this folder, along with a description of what you 
were trying to do, to support@tecplot.com.

On other platforms, no crash dump file is created. However, 
we urge you to send us a report anyway with as much detail 
as you can remember.

If you have a moment and a desire to be extra helpful, please 
re-open Tecplot Focus and choose Enable Diagnostic 
Logging in the Help menu. Then redo the steps you took to 
cause the crash. If you are able to reproduce the crash, send 
the resulting .mcr file to us (along with the .dmp file if you use 

http://www.thinanywhere.com/products/
mailto:support@tecplot.com
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Windows). On non-Windows platforms, you can find the 
.mcr file in /usr/tmp/tecplot_$USER/tpa_diagnostics.

Crash dumps and diagnostic macros are stored in a 
temporary folder and will be eventually be deleted 
automatically. There is no need to delete them manually.

Graphics Drivers
For best results, please make sure that you are using the 
latest graphics drivers compatible with your hardware and 
operating system. These can be obtained from your graphics 
adapter vendor’s Web site. Old versions may have issues 
with Tecplot Focus, especially with larger data sets.

• NVIDIA: https://www.nvidia.com/Download/index.aspx
• ATI: https://www.amd.com/en/support
• Intel: https://downloadcenter.intel.com/Default.aspx

Platform-Specific Notes
The following table outlines the support for various 
platform-specific features in Tecplot Focus 2019 R1.

Refer to the remainder of this section for issues specific to 
your operating system.

Windows

Your account must have administrator rights on your 
computer to install Tecplot Focus, or else right-click the 
installer and choose “Run as Administrator.”

Linux Mac Windows

Excel Loader

https://www.nvidia.com/Download/index.aspx
https://www.amd.com/en/support
https://downloadcenter.intel.com/
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• 32-bit Windows
32-bit versions of Windows are not supported by 
Tecplot Focus 2016 R1 and later. You must use a 64-bit 
version of Windows to run Tecplot Focus.

• Windows XP End-Of-Life
Users run Tecplot Focus on Windows XP at their own 
risk. Microsoft ended support for Windows XP in April, 
2014, and Tecplot, Inc. no longer tests or certifies 
Tecplot Focus on Windows XP. Going forward, we can 
neither guarantee compatibility nor provide technical 
support for Windows XP users.

Linux
• 32-bit Linux

Tecplot Focus is not available in a 32-bit Linux version. 
You must use a 64-bit Linux to run Tecplot Focus.

• Ubuntu Linux
With Ubuntu’s new Unity UI, minimizing Tecplot 
Focus may cause its pull-down menus to become 
unresponsive when the application is later restored. As 
a workaround, you may choose “Ubuntu Classic” or 
“Ubuntu 2D” when logging in, or set your user account 
to use one of these as the default in the Login Screen 
control panel.
Tecplot Focus is supported only on LTS (Long Term 
Support) releases of Ubuntu.

• Unicode Support
Recent Linux distributions can take advantage of the 
Unicode text support incorporated in Tecplot Focus.

• Temporary Directory
Tecplot Focus relies on being able to create temporary 
files in the system temporary directory. On Linux, this 
directory is typically /usr/tmp or /var/tmp. If your user 
account does not have permission to write into the 
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system temporary directory, you can use a different 
directory either by setting the TMPDIR environment 
variable in your profile or by setting the TEMPFILEPATH in 
the tecplot.cfg file.

• Menu Shortcuts
Menu shortcut keys may not work if the NUM LOCK is 
on. You may set the NUM LOCK to turn off 
automatically at boot in your computer’s BIOS.

• SELinux
SELinux (provided with some Linux distributions) 
adds an extra layer of security. If you see this error 
message:

.//bin/tecplot.shared: error while loading 
shared libraries: .//lib/libtec.so: cannot 
restore segment prot after reloc: 
Permission Denied

Enter these two commands, replacing /path/to/
tecfocus/lib with the actual path of your installed 
Tecplot Focus lib directory (your account needs sudo 
permission):

sudo chcon -v -R -u system_u -r object_r -t 
lib_t /path/to/tecfocus/lib/

sudo chcon -t texrel_shlib_t /path/to/
tecfocus/lib/*

You can then run Tecplot Focus without disabling 
SELinux.

• Remote Display Issues
If you have a Network license, you can run Tecplot 
Focus on one computer and display it on a second 
computer (via an X server). The X server must support 
GLX extensions, or else you must use the -mesa option 
when launching Tecplot Focus to have all OpenGL 
rendering performed in software on the host. Working 
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with large, complex files may benefit from the -mesa 
option (see next bullet) even if your X server supports 
GLX.
When displayed remotely, Tecplot Focus may exhibit 
substantially lower drawing speeds than when it is 
displayed locally, especially for text and geometries.

• Mesa Rendering
Mesa, an OpenGL-equivalent graphics library, 
performs 3D rendering in software. It is typically used 
when hardware acceleration is unavailable or when 
working with remote display of large data.
The Mesa version of Tecplot Focus is slower, especially 
for 3D plotting. If you must run the Mesa version and 
display remotely, you can speed up the rendering for 
XY Line and 2D plots by setting the environment 
variable below. On some machines, this may also 
improve the speed of 3D plotting that does not use 
translucency. (Mesa translucency performance is 
known to be very bad.)

export MESA_BACK_BUFFER=Pixmap

Mac
• Keyboard Shortcuts

Previous versions of Tecplot Focus used the Control 
key for most keyboard shortcuts, rather than the Mac 
standard Command key. Tecplot Focus changes these 
shortcuts to use the Command key under Mac. 
Similarly, when rotating a 3D plot, you now hold down 
the Command key while dragging with the right 
mouse button. Note that the Alt key may be called 
Option on some Mac keyboards.

• Right Mouse Button
If your Mac’s mouse has only a single button, hold the 
Control key while clicking to access right-click 
functionality.
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• Middle Mouse Button
There is no functionality in Tecplot Focus that requires a 
middle mouse button; however, it does provide some 
shortcuts. Users of single-button mice cannot emulate 
the middle button, but users of mice with two buttons 
can hold down Control while right-clicking if their 
mouse does not support a true middle-button click.

• 32-bit Macs
The Mac version of Tecplot Focus requires a 64-bit 
processor. Macs with an Intel Core processor (rather 
than a Core 2 or later processor) cannot run the Mac 
version of Tecplot Focus, as they do not support 64-bit 
code.
To determine the type of processor in your Mac, choose 
“About This Mac” from the Apple menu. If the 
processor field displays “Intel Core” or “Intel Core 
Duo”, you have a 32-bit Core processor and cannot run 
Tecplot Focus 2106 R1 or later.

• Remote Display
As Tecplot Focus now uses the native Mac user 
interface on the Mac, you can no longer access the 
application on a remote machine using an X window 
server. Instead, use the Screen Sharing feature, which 
can be enabled in the Sharing control panel (or a third-
party equivalent such as Vine Server, which may 
provide better performance), and a VNC client, such as 
Chicken of the VNC. 
It is not possible for multiple users to run Tecplot Focus 
on a Mac host remotely.

Enjoy Tecplot Focus 2019 R1 and master the view!
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